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Think. Plan. Execute.

Step 1: Think.


In the game show Jeopardy, contestants are given an answer and they have to 
devise the question being asked. This is how I want you to think when you come 
across what we’ve all come to know as “Writer’s Block”.


The fact is, 95% of small businesses are ahead of the curve, but they struggle with 
content. They struggle with the very problem 
of Writer’s Block. You’re not asking yourself 
enough questions. Therefore, your questions 
never get answered, and your audience never 
finds the time to learn about your solutions. 
Take this illustration on the left and think about 
what you are selling. You’re the guy with the 
wheel trying to sell your solution to a group of 

people who are “too busy” to talk about your solutions because you haven’t found the 
time to put together any content. Let’s break this down…


There are 5 stages of customer awareness:


1. Unaware

2. Problem aware

3. Solution aware

4. Product aware

5. Most aware


In the illustration above, the cavemen on the right are completely unaware of their 
problem. If they knew the benefits of using wheels, they wouldn’t be wasting their time 
pulling a cart with blocks as wheels. They might be struggling to purchase wheels.


This is where most small businesses get stuck. They think that there are just two 
types of prospects: brand-aware and brand-unaware. That’s where they’re wrong.


While 60% of your prospects (your audience) may be aware of your brand, only 5% 
of them may be ready to purchase your solutions. If you are focused on your brand, 



Think. Plan. Execute.  |  3

you’re focused on the wrong thing. You don’t need to focus on the 60% aware of your 
brand. You need to be focused on the 5% that are ready to purchase.


Your identity is more than just your brand.

Your brand is important, but what about your brand voice? What about your team? 

What about the products that you sell? Your training courses? Your onboarding? Your 
follow-up? All of these things tie together to create your identity.


Your brand doesn’t answer questions. It’s just a marker—a reminder—a vessel of 
opportunity. The opportunity lies in marketing your solutions, not your brand.


So, think. 

Think about the questions that your audience would ask. Research your solutions. 

Find the questions that people have about your products (or solutions). Open Google 
and search through all of the questions that people have asked about your products or 
services. Keep researching and keep writing. Keep thinking, and keep solving 
problems.


Just like in Jeopardy, you have to take the solutions that you provide, find the 
problems, ask yourself, “How would I solve that problem?”, and then market your 
solutions to those problems. How would you sell the wheels to the cavemen?


You can’t find a good answer to a bad question and there are no solutions to 
problems that don’t exist.


If you’re running a small business, and you feel like you’re getting stuck, you need to 
start asking questions.


Think. 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Up & Running

Lesson 1: Introduction


FOLLOW ALONG AT HTTPS://IMGFUNNELS.COM/HELP 

Welcome to the Up & Running course for IMG Funnels! Each lesson has a video. 
Each section has a quiz. Purchase the videos and quizzes for this course at https://
checkout.imgfunnels.com/online-courses. In the videos, I walk through each lesson 
one by one and explain each step in order—as they appear in the book.


During the course, you will hear me referring to IMG Funnels as "Image Funnels". 
This is because IMG is an abbreviation for "image". For example, in HTML, an  
<img/> tag is used to represent an image.


We will use a "Demo" account during the course to prevent leaking any personal 
data or information.


Getting Started


Here's what you will need:


You may want to create an account before you start this guide. Start 
your free trial at https://imgfunnels.com/signup. Without an account, you 
won’t be able to follow along with some of the tutorials.


You will also need a registered domain. You can register a domain with 
DreamHost using our referral link at https://dmholdingsinc.com/
dreamhost


The Launchpad


The first thing that you will see when you log into your account will be The 
Launchpad. Follow the steps in the Launchpad to help you get started as quickly as 
possible.


https://imgfunnels.com/help
https://checkout.imgfunnels.com/online-courses
https://checkout.imgfunnels.com/online-courses
https://imgfunnels.com/signup
https://dmholdingsinc.com/dreamhost
https://dmholdingsinc.com/dreamhost
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1. Install the mobile app (called “LeadConnector”). Available on:

A. Google Play

B. Apple App Store


2. Connect your Google Business Profile

3. Connect your Facebook account

4. Install the Chat Widget

5. Connect your Stripe account

6. Add Team Members


Tip: The Launchpad is a quick way to get started but it doesn't cover 
everything. If you would like to continue with more business 
integrations, go to Settings > Integrations. 

Your personal integrations are available in Settings > Profile (under 
Business Services).

Your Domain


Your domain is the address (or URL) associated with your website.

Add your domain to your account by navigating to Settings > Domains.

Tip: If you already have a website or if you plan on using another builder, such as 

WordPress, you may want to use a subdomain instead of your root domain.* 
Something like the app subdomain (app.example.com) will work.


⚠  Caution! ⚠  Setting an A record or a CNAME record with your root domain will 

redirect all traffic on your website to IMG Funnels.
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What is a root domain?

A root domain consists of the protocol and domain name. It may not 

have a subdomain, a path, a query, or a fragment.


Tip: If you would like a jumpstart on SEO*, check out this blog post 
(https://www.dmholdingsinc.com/help/how-to-convert-leads-easily/) 
from our parent company, DM Holdings: Up & Running With SEO. 
SEO will help internet users to find your site using search engines.

What is SEO?

Search Engine Optimization, or SEO, is the process of improving the 

quality and quantity of website traffic to a website or a web page from 
search engines. SEO targets unpaid traffic rather than direct traffic or 
paid traffic.


Social Media


Start by navigating to Dashboard > Marketing and then select the Social Planner 
tab.


The Social Planner allows you to post to multiple social media platforms at the same 
time.


• Use this feature by building an editorial calendar and implementing a Content 
Strategy.*


• You should post regularly and run paid ads to keep your social media active.

• You can integrate Facebook, Instagram, Google My Business, LinkedIn, and 

Twitter!

• It's recommended that you use your blog to build content for social media.


What is a Content Strategy?

Content strategy is the planning, development, and management of 

content—written or in other media.


Tip: Your account manager can perform several content and SEO-
related tasks for you. This includes social media account creation 
and management.

https://www.dmholdingsinc.com/help/how-to-convert-leads-easily/
https://www.dmholdingsinc.com/help/how-to-convert-leads-easily/
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Adding Contacts


Your contacts are the lifeblood of your business. If you already have a list of 
contacts, you can import them into IMG Funnels by navigating to Dashboard > 
Contacts and clicking the Import Contacts button.





To add contacts manually, click the Add button.


Tip: If you don't have any contacts yet, don't worry. We will cover the topic of lead 
generation in another lesson.


Workflows


Every time someone fills out a form created with the Form Builder, their information 
goes into Contacts and they are categorized as a Lead by default. The Form Builder 
can be found by navigating to Sites > Forms > Builder.


You can customize your leads' experience by navigating to Automation > 
Workflows and then clicking the button that says "Create workflow”.
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Add a Form Submission Trigger and link your form to place Leads into your 
Workflow.


Tip: You can create Standard Operating Procedures by using the Add 
Task Action in your Workflows. More about Workflows in another 
lesson. Check out our Task Manager widget from Dr. HighLevel.

What is a Standard Operating Procedure (SOP)?

A Standard Operating Procedure, or SOP, is a set of step-by-step 

instructions compiled by an organization to help workers carry out 
routine operations. 

https://www.imgfunnels.com/help/up-and-running/drhighlevel.com
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Lesson 2: How To Improve Performance


The ideal load time for both mobile and desktop websites is anywhere from 1-2 
seconds, but improving performance is about more than just loading speed! While it's 
important to keep your site optimized, as a business owner, you also have to stay 
ahead of the curve when it comes to sales and technology. Your offer(s), the content 
that you post, the quality of your site (UX/UI), your products and services, customer 
support or reception—all of these things tie in together to produce a well-performing 
website.


No matter how good you are at your job, there’s always room for improvement. If you 
want to succeed, you need to be constantly learning and improving your skills! 


Here Are a Few Suggestions


It’s time to start improving your skills as a business owner. Use the tips below to get 
started, and don’t forget to keep learning new things. The more you know, the better 
you’ll be at your job.


Stay up to date with the latest trends.

The web development world is constantly changing. New 

technologies are being developed all the time, and it’s important to 
stay up to date with trends. You can do this by reading articles, 
attending conferences, and following thought leaders on social media.


Experiment with new technologies

Don’t be afraid to experiment with new technologies. It’s the only 

way to learn about them and see if they’re a good fit for your workflow.


Get feedback from others

Getting feedback from other business owners is a great way to 

improve your skills. Ask for feedback on your code, your development 
process, and your overall approach to web development. Of course, 
it’s not enough to just get feedback from others – you also need to be 
open to it. Be willing to listen to constructive criticism and use it to 
improve your work.
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Experiment with new technologies

Don’t be afraid to experiment with new technologies. It’s the only 

way to learn about them and see if they’re a good fit for your workflow.


Take courses and learn from experts

If you want to improve your skills, there’s no substitute for taking 

courses and learning from experts. Plenty of online courses are 
available, as well as in-person courses and boot camps.


Practice, practice, practice

The best way to improve your skills is to simply practice as much as 

you can. Build personal projects, contribute to open source projects, 
and work on real-world projects. The more you code, the better you’ll 
become.


Never stop learning

The most successful business owners are the ones who never stop 

learning. They’re always looking for new ways to improve their skills 
and their workflow. If you want to be successful, you need to do the 
same.


Using a CDN


A Content Delivery Network (or CDN) like Bunny.net is a great way to get started with 
cloud-based content delivery! A CDN works by storing your files on a network of 
servers around the world and then serving those files from the location that is closest 
to your visitor. Bunny CDN is relatively inexpensive compared to other CDNs and it's 
super easy to get started!
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While Cloudflare identifies as a CDN, it doesn't work in the way that a traditional 
CDN works. Cloudflare is more for proxying your site, protecting it from DDoS attacks, 
setting DNS records, and caching your site on a global edge network.


Tip: A traditional CDN like Bunny.net stores your files on a global 
network and then serves your files to your visitors from the nearest 
location.

Plugins


IMG Funnels' page builder is designed to output a static page every time you save. 
So, if you're using the IMG Funnels page builder, you shouldn't have to worry too much 
about performance. If you're using WordPress, however, there are a few caveats. Try 
using a plugin like WP Rocket (https://wp-rocket.me/) to improve performance on your 
WordPress website.


While plugins are fun to add, if you don't vet your plugins before you use them, they 
can slow your site down. If your server* can't keep up with the load, or if your plugins 
are full of errors, your visitors will experience degraded performance. If your site 
seems slow, you may want to consider an alternative. Extracting a plugin's 
functionality** can be a tedious process. The ultimate goal is to reduce the number of 
requests that your site is making to other networks and use only what you need.


What is a server? *

Your website runs on a computer—your server. It's managed by your 

hosting service provider. You probably noticed when you purchased a 
hosting plan that the product (or service) details contained 
specifications for a computer (or a network of computers). If your 
website is slow, you can purchase a larger server to improve 
performance on your site.


What is functionality?


https://wp-rocket.me/
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Functionality refers to the range of operations that can be run on 
your server. While you do need the functionality, you don't want to 
install a bunch of plugins that are going to slow down your website.


Tip: Customers don't like slow websites! If you need a functional 
website, consider building an app or consider offloading your plugins 
to another site (or sub-domain).

Tip: If you have $40 to spend on an annual subscription, WP Rocket 
(https://wp-rocket.me/) is highly recommended! We recommend WP-
Optimize (https://getwpo.com/) as a free WordPress optimization 
plugin.

Images


Image Optimization is the process of delivering images that are optimized for use on 
the web. If not properly optimized, images can slow down your website, making it 
difficult for visitors to view your content. If you're using WordPress, Imagify (https://
imagify.io/) is great for image compression, formatting, and overall performance!


There are two main ways to optimize images for the web: file format and size.


https://wp-rocket.me/
https://getwpo.com/
https://imagify.io/
https://imagify.io/
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The file format is the type of image you use. The three most common image file 
formats are JPEG, GIF, and PNG. Each has its benefits and drawbacks. There are two 
"next-gen" formats called WEBP and AVIF that have performance benefits and are 
recommended by Google Lighthouse (https://developer.chrome.com/docs/
lighthouse/overview/).


JPEG supports millions of colors and produces a high-quality image. However, 
JPEG files are large and can slow down your website.


GIF is best for images with few colors, such as line drawings or logos. GIF files are 
smaller than JPEGs, so they load faster. However, they don't support as many colors, 
so they can look "blocky."


PNG is a newer format that supports millions of colors and produces a high-quality 
image. PNG files are smaller than JPEGs, so they load faster.


Tip: Size is the other factor to consider when optimizing images for 
the web. Image files can be very large, which can slow down your 
website. To avoid this, make sure your images are the appropriate 
size for their use. Generically speaking, you should attempt to keep 
your images under 70KB in size.

Tip: We recommend Imagify for image compression and 
performance.

Videos


A quick message about videos. If you’re just getting started, you may want to go with 
a streaming service. Another way to add videos to your website is to use a bucket and 
an HTML 5 <video> element, but that’s an advanced topic for another course. The 

reason we don’t recommend uploading the entire video to your site and hosting it 
statically is that the browser will attempt to download the full video before loading the 
website. Instead, use a streaming service like YouTube (recommended) or Vimeo.


Tip: If you’re just getting started, we recommend hosting your videos 
with a streaming service such as YouTube or Vimeo.

https://developer.chrome.com/docs/lighthouse/overview/
https://developer.chrome.com/docs/lighthouse/overview/
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Conversion Optimization


Note the difference between a traffic funnel and a sales funnel. Sales funnels are 
where you collect a payment from your customers. They are supposed to be short and 
to the point. Traffic funnels, on the other hand, are larger systems that are intended to 
re-target your audience. Both deal with conversions.


One tip to stay ahead is to use a tool like Geru (https://www.geru.com/) to help you 
visualize and plan a campaign before you begin.


Tip: Check industry standard conversion rates, and if you fall below 
the average for your niche, run an audit to help you increase your 
conversion rate.

https://www.geru.com/
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Search Engine Optimization


Search Engine Optimization (or SEO) is the process of improving the quality and 
quantity of traffic to a website or a web page from search engines. SEO targets unpaid 
traffic rather than direct or paid traffic*.


When you are optimizing your site for search engines, it's important to remember 
that most of your SEO (unpaid) traffic is going to consist of first-time visitors!


According to The 3 Second Rule**, you have a maximum of 3 seconds to capture 
and interest your audience plus leave them with a memory of your brand.


The next lesson is all about Search Engine Optimization, so mark this lesson as 
complete and I'll see you in the next lesson.


Paid Traffic *

Paid traffic refers to traffic that visits your site from a paid 

advertisement.


Get feedback from others

The "Buyer's Journey" describes the process a customer goes 

through to purchase a product or service.

The steps of a buyer’s journey typically go like this:

• Brand Awareness: During this phase, the customer is seeing 

your brand for the first time. This is your first impression.

• Consideration: During the Consideration phase, your potential 

customer may have responded to a post or contacted you in some 
form or fashion. Now is your chance to respond!


• Decision: During the Decision phase, you have responded to 
your potential customer with an offer or a quote. It's now up to them 
to either schedule a meeting with you or purchase your product or 
service directly from your website.


The 3-Second Rule

The first time that someone sees your brand, that's their first 

impression of your company. In SEO, you are mainly dealing with first 
impressions. You have a maximum of 3 seconds to capture your 
audience's attention and make a lasting first impression. This is why, 
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for small businesses, we recommend focusing on paid and/or direct 
traffic—because it's easier to make a better first impression with paid 
ads, topical content, and/or social media.


Tip: Search Engine Optimization can be sort of a "rabbit hole" for 
many startups. If you over-optimize, you can hurt your reputation and 
end up near the bottom of the search results. Follow the instructions 
on the next page for best practices.
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Lesson 3: Search Engine Optimization


Search. Engine. Optimization. (SEO)

Break it down word for word and start from square one.


1. Search: First, you need something worth searching for—your content and 
the links within your content.


2. Engine: After you have enough content that requires a search, you need an 
engine to be able to search that content.


3. Optimization: Now that you have content to search for, and you have an 
engine with an algorithm to search that content, you need a way to put the most 
relevant content at the top of the results.


“ONE OF THE BIGGEST TRAPS FOR SMART ENGINEERS IS  
OPTIMIZING SOMETHING THAT SHOULDN’T EXIST.” 

- ELON MUSK 

Did you know that 70% of sales are either remote or digital self-service? Search 
Engine Optimization (or SEO) plays an important part in remote sales. Around 40% of 
your traffic comes to your site from organic sources such as Google.


Search engines use algorithms to determine what shows up at the top of their search 
results. Google's PageRank (https://en.wikipedia.org/wiki/PageRank) algorithm is a 
prime example of a formula that is designed to help users find what they're looking for. 
In a nutshell, the algorithm crawls the internet looking for links to your website. The 
more links that you have going back to your website (called "backlinks"), the closer 
your website will be to the top of the search results.


Don't do it backward and try to optimize before you have content that's worth 
searching for. Write the content first, then optimize.


What are backlinks?

Backlinks (also known as “inbound links”, “incoming links” or “one-

way links”) are links from one website to a page on another website. 
Google and other major search engines consider backlinks “votes” for 
a specific page. Pages with a high number of backlinks tend to have 
high organic search engine rankings.


https://en.wikipedia.org/wiki/PageRank
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Getting Started


SEO will help you build a website that keeps users coming back for more. It's about 
more than just the first impression, it's about optimizing your site for search-ability. If 
you're using WordPress, for example, your site comes pre-built with its very own 
search engine. If you are following SEO best practices, not only should your site show 
up higher in search results on Google, but users should also be able to find exactly 
what they need when they need it.


Your users should be able to find what they need when they need it.


Setup


The first step is to set up Google Search Console. With this tool, you will be able to 
visualize your business on Google. Use this tool to help you get to the top of the 
search results!


The process is fairly intuitive. Simply fill out the form and you're ready to go!


Go to https://search.google.com/search-console/about to get started with Google 
Search Console.
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Google Business Profile


Now that you have set up your Search Console, you should continue by creating a 
business listing on Google Business Profile (previously Google My Business). Again, 
the process is fairly intuitive. Just click here and fill out the form.


Go to https://www.google.com/business/ to get started with a Google Business 
Profile.





Yext


 Another option (and there are many like this), is to set up local listings. Other similar 
services include BrightLocal, Moz Local, LocaliQ, and there are a handful of others. 
We choose Yext because they have more features, including review management. 
There are some web agencies that simply white-label Yext and resell it. If you are 
having trouble setting up your business online and you just need local listings (this 
would be for a gym or a restaurant), you can just use Yext to set up your listings.
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RankMath


The RankMath SEO plugin integrates seamlessly with Divi by Elegant Themes, our 
WordPress Theme of choice. If you have not yet installed Divi, reach out to your 
account manager and we will be more than happy to help with a free copy so long as 
your subscription is active. Simply install the free plugin (https://wordpress.org/
plugins/wordpress-seo/) and complete the installation wizard (https://rankmath.com/
kb/how-to-setup/) to complete this step.


Tip: For the most part, SEO is all about setting up listings, following 
best practices, and watching your dashboard. Whether you are in a 
niche that is highly dependent on reviews (restaurants, gyms, etc.), 
or if you are selling products online (e-Commerce), there is a 
strategy out there that will work for you. Set up review management 
accordingly and review your analytics regularly.

Analytics


An easy way to set up Google Analytics with WordPress is to install a plugin called 
MonsterInsights (https://wordpress.org/plugins/google-analytics-for-wordpress/). 
Simply install the plugin from your WordPress Dashboard and follow the Install Wizard.


Another (more advanced) way to install Google Analytics is through a platform 
called Segment, but that’s a more advanced topic for another course.


https://wordpress.org/plugins/wordpress-seo/
https://wordpress.org/plugins/wordpress-seo/
https://rankmath.com/kb/how-to-setup/
https://rankmath.com/kb/how-to-setup/
https://wordpress.org/plugins/google-analytics-for-wordpress/
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While we’re on the topic of Analytics…


Setting up analytics is fairly straightforward. You just plug some code into your 
website and watch the numbers. Here are some other tools that you should consider 
using:


• Facebook Pixel

• Ahrefs Webmaster Tools

• Bing Webmasters

• Yandex Webmaster Tools

• Baidu Webmaster Tools

• Google Postmaster Tools


Tip: Your analytics will help you target your ads later down the line, 
so make sure you set up at least two analytics platforms. At the very 
least, set up Google Analytics and Facebook Pixel.

Improving Site Health


Site health is a metric that many SEO & Webmaster tools provide to measure your 
site's structure, speed, and security. While your site isn't a living, breathing thing, it will 
start to deteriorate if you don't take care of it.


On-Page SEO, Loading Speed, Regular Maintenance, Mobile-Friendly 
"Responsiveness", and Hosting are all common factors used to determine your site's 
health.


Here is a guide to help you improve your site's health:


On-Page SEO

• Do you have any broken links?

• Do you have too many (or not enough) subtitles or headings?

• Is your website structured?

Fix broken links and issues regarding your content like title tags, h1 

tags, meta descriptions, and images.


Loading Speed


https://www.facebook.com/business/tools/meta-pixel
https://ahrefs.com/webmaster-tools
https://www.bing.com/webmasters
https://webmaster.yandex.com/sites/add/
https://ziyuan.baidu.com/site/siteadd
https://www.gmail.com/postmaster/
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• Does your site take longer than 3 seconds to load on 5G? If so, 
you may need to optimize it.


• How long does it take to load on a 3G connection?

Reduce file sizes by removing unused plugins and compressing 

images. Improve server response times by upgrading your hosting 
plan. Serve content with a CDN like Cloudflare.


Regular Maintenance

• Do you have any themes installed that you're not using?

• Do you have any plugins that need to be updated?

• Does your site have any vulnerabilities?

Remove unused themes or plugins. It's a good idea to enable 

automatic updates. Remove spam and run a security check. Post 
content on a regular schedule to help you remember to maintain your 
site.


Mobile-Friendly

• Are you using a responsive design?

• Does your site work the same on mobile as it does on desktop?

 Use a responsive design to ensure that your site looks just as good 

on mobile as it does on desktop. Remember, mobile devices don't 
have as much processing power. You still need your site to load in 
under 3 seconds.


Hosting

• Do you need to upgrade your plan?

• Are you performing backups on a regular schedule?

Work with a web hosting provider that you trust. Back your site up on 

a regular schedule. Upgrade your plan if needed.


Tip: A healthy site is more likely to show up at the top of search 
results. Regularly post content and maintain your site to keep your 
site “healthy".
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Content Strategy & Targeting


Once you have your analytics set up, it's time to start targeting your audience. Think 
of it like a ski lodge. At the ski lodge, there are "Bunny Slopes" (or Green Circles), Blue 
Squares, and Black Diamonds. Your evergreen content that gets indexed and crawled 
by search engines are your "Green Circles". When a prospect (the "skier") views your 
content, you can tell search engines (like Google) and social media platforms (like 
Facebook) that that specific person viewed that content. If you have set up targeting, 
any paid advertisements that you are running will show up in that person's news feed 
or search results (as a "Sponsored" post or listing).


What is Evergreen Content?

Evergreen content is search-optimized content that stays "fresh" 

over a long period (hence the name). This is information about your 
business, your listings, content about your company, and anything that 
pertains to an aspect, be it a product or service, that is not likely to 
change over time.


But what happens if a new "skier" (the prospect) tries to go down a Black Diamond 
without first trying the Green Circles or the Blue Squares? They're going to fall face 
first and head over heels.


Your targeted advertisements are like "Black Diamonds".

The "Blue Squares" in this illustration are topical content, like your social media and 

blog posts, main pages, and high-value content (HVCOs) that you deliver via e-mail or 
SMS.


This is why you have to post content regularly before you start targeting. You don't 
want to target a prospect that doesn't even have brand awareness. When a prospect 
views your content, then it's time to target them. They are aware of your brand. You 
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should post content about your products or services so that people can get to know 
your company better.


Your Ads and your Analytics work together to optimize delivery. This is called 
"audience targeting”.


Preparing for Targeted Advertisements


Here is a quick guide to help you set up targeted advertisements. There will be 
another lesson on this topic later in this course:


Google Analytics

Install the Google Analytics code on your site. If you need to 

optimize for specific events (such as an Add to Cart), then you can 
also optimize your targeted ad delivery to target prospects who have 
added products to their cart.


Tag Manager

Install the Google Tag Manager code on your site. This is how you 

will track events on your website. While it's not mandatory to set up 
events, you may want to use Tags for important actions, like Add to 
Cart, Lead Form Submission, Purchase, Sign Up, etc.


Pixel Tracking

Install the Facebook Pixel code on your site. You can also optimize 

for specific events using the Facebook Pixel.


Tip: Post content regularly to improve the performance of your 
targeted advertisements.
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Lesson 4: Using The Page Builder


The Page Builder is designed to help you build websites and funnels without having 
to write code.


If you've ever hard-coded a website, you know that a lot of the setup can be tedious. 
Things change, they break, and it's just easier to use a drag-and-drop User Interface 
(or UI) to build a website. Searching for tags, outlining the document, using a 
boilerplate, connecting analytics and pixels—all of this becomes much easier to do 
(and it's faster) with our Page Builder.


Getting Started


Essentially, the Page Builder helps you design websites.


If you haven’t signed up already, you will need an account. Start your 
free trial today at https://imgfunnels.com/signup


WordPress will be covered in another lesson. This lesson is about the 
IMG Funnels Page Builder and not the WordPress page builder or Divi. 
Those topics will be covered in another course.


Overview


The Page Builder makes building a website easier. You have control over your SEO 
and tracking codes, you have a handful of elements, responsive design, placeholders, 
custom values, and the ability to connect anything from IMG Funnels to your website.


Since this is just an overview and not a lesson about the system itself, we will limit 
this lesson to the scope of the features that are directly in the page builder itself.


• SEO Meta Data

• Tracking Codes

• Global Settings


• Custom CSS (topic will be covered later)


https://imgfunnels.com/signup
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• Background


• Typography

• Responsive Design


• Sections


• Rows


• Columns


• Elements

• Spacing


• Padding


• Margin


Tip: The Page Builder writes all of your Cascading Style Sheets (or 
CSS) for you. CSS is the design language of the internet.

Templates


Templates provide you with a way to get started that will help you get up and running 
as quickly as possible. Instead of valuable time building a Custom CSS Layout, you 
can instead import a template. You can edit (or "white-label"*) the template to match 
your brand's specific style.
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What is white labeling? *

White labeling is the process of taking a product or service (such as 

a website) and rebranding it to match your company's style 
specifications. Many companies will use a "Style Guide" or a "Brand 
Kit" to help them maintain a uniform style throughout their website (or 
catalog).


Here are a few things that you might see included in a Style Guide or Brand Kit:


• Colors

• Typography

• Logos


• Square


• Document Header

• Brand Assets


• Imagery

• Contact Information


• Email


• Phone Number


• Physical Address


You should do your best to use templates—customize them to fit your brand—and 
then optimize for SEO and deliverability. For example, if you have a series of blog 
posts, you can use a template for each post and then simply edit the content inside—
saving you time and money.


Tip: Almost all code that is written for marketing is derived from some 
sort of form or template. You can set Custom Values in your 
Company's Settings area and use placeholders to help you fill out 
templates quickly. You can also save templates to your global library 
and use them anywhere. That way, for example, you don't have to re-
create the same header or footer every time you want to add a 
header or footer to your website.
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Adding Products


You can add products to funnels by going to Sites (1) > Funnels > Select a Funnel 
> (2) Steps > (3) Products.


Then, as long as you have a payout account (Stripe or PayPal) connected to your 
Location*, you will see the product on your website.


What is a Location (or a Sub-Account)? *

A "Location" is like an"Office Suite" in IMG Funnels. Your first two 

locations are free. Additional locations require an Upgrade. Upgrades 
are coming soon.


You can manage your Products by going to Payments > Products. In this example, 
I am using a 14-day free trial on a product that costs $30 per month.
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Tip: Integrate Stripe (or another payout service) with your account. 
Then, manage your products using IMG Funnels (not Stripe). 
Inventory Management is often misunderstood and undermined. You 
should create categories for your products to help you remember 
where everything is.

Checkout


Once you have added a product, you can then add an Order Form (1 Step or 2 Step) 
to your website. That Order Form will then be linked to the product that is added to the 
Funnel (or Website).


In this example, I'm using a 1-Step Order Form.


(see next page)
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And on my site, you can see the checkout, which will reflect my 14-day free trial.


And if I disable the trial, the customer is charged up-front for my product or service.
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Tip: Remember! All of this can be customized using CSS. If you don't 
like the look or feel of your checkout funnel, ask a developer who can 
help!

Tracking


By now, you should be familiar with Google Analytics and the Facebook Pixel.

To install your tracking code(s), all you have to do is click Settings > Tracking Code.
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Tip: Tracking will help you gain more traffic by sending data to 
platforms like Google and Facebook, which will then optimize the 
delivery of your content to target individuals in your audience that 
have expressed interest in your products or services. You only need 
one Pixel per ad account. (we'll cover the topic of ad accounts 
another time).
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Lesson 5: Choosing a Strategy


At this point, you should choose a strategy and focus on either Lead Generation or 
e-Commerce. If you're unsure, you can follow this lesson to help you choose.


FYI

While it's optional to take both sub-courses, you only have to 

complete one of the quizzes to pass this course. You don't have to 
take both sub-courses to pass the overall course.


Getting Started


By now, you should have started your free trial and you should have a decent overall 
understanding of how to build websites.


Lead Generation

If your products or services are over $500 or you conduct your sales 

in person, you should be using the Lead Generation strategy.


e-Commerce

If your products or services are under $500 or you conduct your 

sales online, you should be using the e-Commerce strategy.


Lead Generation


Tip: Most Lead Generation services are included with your IMG 
Funnels account. IMG Funnels is designed specifically for Lead 
Generation.
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INTRODUCTION TO LEAD GENERATION (p. 40)


e-Commerce


 Tip: IMG Funnels is designed for one-click checkouts and single 
product pages, but it integrates seamlessly with WordPress. Some of 
the lessons on inventory management will focus on WordPress with 
WooCommerce.

INTRODUCTION TO E-COMMERCE (p. 68) 


https://www.imgfunnels.com/help/introduction-to-lead-generation/
https://www.imgfunnels.com/help/introduction-to-e-commerce/
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Step 2: Plan.

Most successful entrepreneurs do not use to-do lists. They use a method called 

“time blocking”. Planning is the act of scheduling your tasks (on a calendar). If you’re 
like me, you get interrupted a lot at work. While you can’t plan for interruptions, you 
can prioritize your tasks by planning your schedule ahead of time. You shouldn’t 
schedule interruptions. Sometimes, you may create a task, later decide that it’s an 
interruption, and remove it from your schedule. A task isn’t planned until it’s 
scheduled.


If you haven’t already, try our Task Manager solution built in Make/Integromat for 
HighLevel and Google Calendars.


Planning isn’t so much about getting everything in chronological order (some tasks 
can be completed simultaneously) as it is about filling up your calendar (and your 
team’s calendar) with tasks and scheduled events. If you need help, teach someone 
how to do what you do! Hire a VA to learn what you do, vet that assistant, and 
outsource some of your work. Unless you work in some sort of licensed position 
(doctors, lawyers, and even developers—to some extent), don’t try to do everything 
yourself.


Focus on your calendar and choose your battles. If you can make $175 per hour 
doing one task, and another makes you $97 per hour, don’t fill up your calendar with 
tasks worth $97 per hour. Do the best you can to charge as much as possible.


If you feel like you’re being short-changed, find a community. It’s very possible to 
isolate yourself to the point where you have zero reputation. People will begin to 
lowball you for not being trustworthy.


That is a very difficult situation to deal with (I know from experience), so align 
yourself with other like-minded individuals who work in the same niche as you. 


Plan for the future by creating a community. Create a course! Sell your course and 
add your course members to your community! Wash, rinse, and repeat.


Learn how to manage your analytics. Avoid launching a campaign without having 
measurable results. That is how you plan.


Depending on your level of experience, this can be anything from using on-platform 
analytics from your ads on social media to managing log drains and creating 
dashboards to help you keep track of the important metrics.


Plan for scalability. If you have 100 clients and intend to launch a campaign that 
might get you 1,000 clients, do your best to predict the bottlenecks and problems that 
will inevitably arise from scaling.
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Don’t sell yourself short. Plan ahead.


The Proven Method


During the Execution Phase, we will focus on tracking prospects in your funnels, so 
during the Planning Phase, we will be setting the structure for your sales process. You 
don’t want to wait until your campaign goes live to determine how you will handle 
sales.


If you haven’t already, you will need to set up your “stack”. Here are a few steps that 
you can take to get started:


1. Domain/Branding

1. DNS Records

2. Use a “BrandLock” service for social media


2. Email Marketing

1. Set up your email domain

2. Build a 52-week follow-up sequence


3. Build your SEO (There’s a full lesson on page 25)

1. Create a Low-Risk HVCO (more about this later)


4. Post on Social Media

1. Platform agnostic

2. ~6 posts per day


5. Run Paid Advertisements

1. Media agnostic


The Sales Process


For Lead Generation/Services


If you’ve made it this far, you’re likely running an agency or just getting started with 
one. First of all, if you are selling digital services, do not sign NDAs! If you sign an 
NDA, you’re setting yourself up for failure. You could base your entire sales process 
around doing just the opposite of signing an NDA and you would do just fine.
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And I know that it’s different for every niche. You may be a lawyer who is trying to 
learn how to build your CRM, for example—or you might be a marketer in the plumbing 
niche—however, you should already know what an NDA is by now.


Signing an NDA is one of the worst things you can do if you’re trying to make a name 
for yourself. I made a video about this on our YouTube channel (https://youtube.com/
@imgfunnels). Just search for “Hiring a Developer”.


You want to make your services reusable and by signing an NDA, you’re signing your 
“license” to practice that service away to a client. Think of how a doctor sells their 
services.


Doctors are required by law to follow HIPAA compliance. That means that all 
information about the client (their records, diagnoses, prescriptions, etc.) is held 
confidential in the doctor’s office. Straight away, there’s no need for the doctor to sign 
anything like an NDA—they’re already bound by law to practice HIPAA compliance. If 
they don’t follow that law, they lose their license.


Now think about how hospital administrators run their business.

The owner of a hospital cannot treat patients without a licensed doctor. I’m sure they 

would love to have a doctor sign something stating that they cannot practice medicine 
outside of their hospital! That’s what happens when you sign an NDA.


If your client is trying to get you to sign an NDA—they’re trying to take your license 
away from you and force you to provide a service to them and only them. It’s a trap!


However, as long as the doctor is licensed, they can take their practice outside of the 
hospital.


This is how you should think about your sales process.

As a doctor ([insert your profession here]), you have patients (clients), and you need 

a front desk (a CRM) to be able to take in “patients” so that you can make sales. As 
soon as you sign an NDA, you position yourself as a doctor who cannot practice 
outside of a hospital—you become completely dependent on the administrators (your 
client) for sales! Don’t do it!


Avoid signing NDAs at all costs!

Some clients won’t know the difference, they just don’t want you to disclose 

anything about their services, and that’s fine, but you have to be able to take your 
practice with you once all is said and done.


I know that NDAs don’t apply to every profession, but every time you sell something 
or you work for a client, you have to continue selling your products or providing those 
services to other clients—otherwise you become dependent on your client.


https://youtube.com/@imgfunnels
https://youtube.com/@imgfunnels
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The second thing that I want you to understand is that you need a low-risk high-
value content offer (HVCO). Without a high-value content offer, you’ll burn up your 
marketing budget trying to target the top 3% of buyers. More about this later.


The Case for e-Commerce


If you’re running an e-Commerce store—selling physical products—it’s a little 
different. However, consider the legal risks involved. You never want to sell to a 
customer that would put you in a vulnerable position. Instead of dealing with the risks 
of signing an NDA, you’re dealing with the risk of selling faulty products, products 
getting damaged during shipment, and customers using the product in the wrong way. 
Think of how a pharmacist sells their products. They give you instructions, you sign a 
document, and you take your prescription with you.


The sales process for e-Commerce is a little more straightforward. All you have to do 
is write up a disclaimer and you’re golden.


The Problem


The glaring issue that I see most business owners face is that their ideas get lost in 
translation. You have a great idea, but you just can’t get that developer in some other 
part of the world to understand what it is that you want—and the developer doesn’t 
understand what you want because you keep throwing solutions at him like it’s a circus 
act.


You’re losing 95% of your ideas because they’re getting lost in translation.


The Solution


You need a Managed Service Provider (MSP).


You need someone who can manage your services for you and show you how to 
“time block” your schedule instead of creating a huge list of tasks. Focus on your 
sales. If development isn’t for you, then hire a developer—or hire an MSP or an IT 
Services company to outsource your development for you!


Think about it like this…
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The 80/20 Rule


Also known as the Pareto Principle, the 80/20 rule states that roughly 80% of the 
effects come from 20% of the causes. It was named after Italian economist Vilfredo 
Pareto, who observed in the early 20th century that 80% of the land in Italy was owned 
by 20% of the population.


The 80/20 rule implies that 80% of a company's revenue comes from 20% of its 
customers or that 80% of a company's profits come from 20% of its products. In 
personal productivity, it suggests that 80% of results come from 20% of efforts or 
tasks.


That means that 20% of your tasks account for 80% of your revenue. Therefore, 
20% of that 20% of tasks account for another 80% of that 80%. So—4% of your tasks 
generate 64% of your revenue. 


Instead of trying to do everything yourself, just focus on the 4% of your tasks that 
generate sales and outsource everything else.


Here are some examples:


1. Writing sales copy

2. Coming up with offers & promotions

3. Creating sales funnels

4. Shooting videos

5. Doing webinars

6. Scheming & plotting


Plan. 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Lead Generation


Create New Opportunities


Lead generation is the process of attracting and converting your audience into leads, 
or potential customers. It's a crucial part of the sales process, and it can be done 
through a variety of channels, including search engines, social media, marketing, 
public relations, and even word-of-mouth.


Following these tips, you'll be well on your way to generating leads for your business.


Getting Started


There's no one-size-fits-all approach to lead generation, but there are some best 
practices that all businesses should follow. 


Here are a few tips:


Define your target audience.


Create compelling content.


Create an attractive offer.


Use effective lead capture forms.


Utilize lead nurturing strategies


Measure your results
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Defining Your Audience


Your target audience is your sphere of influence and those who have been identified 
as likely consumers of your products or services. Marketing audiences can be 
segmented (or targeted) by factors such as occupation, income, location, and 
interests.


When you are getting started with audiences, you should first define a list of criteria. 
If you are running a gym, for example, you should target people who are interested in 
"weight loss" or "nutrition". These are examples of interests that would be common in 
the fitness niche.


 Another example is the B2B model. For this model, you might target things like 
"business owners" or "entrepreneurs". These are examples of occupations that you 
might use for the B2B niche.


Tip: Try to think of at least 5 criteria for your niche and write them 
down. You will need these later when you set up targeted ads.

Posting Content
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The content that you post to your blog or social media will set the pace for your 
traffic. It's recommended that you post to social media no more than 6 times per day. 
While you might think that's a lot, not all of these posts need to be a full 300-word blog 
post. Have fun with it (try using meme marketing)! Use our Social Planner to help you 
schedule posts ahead of time and stay ahead of the curve!


Tip: If you, like most people, don't have time to write a full blog post 
on your products or services, just post a simple image with a few 
sentences to capture the viewer's attention. Then, follow up with a 
comment on the post directing the viewer's attention to your offer.

Creating Offers


Possibly the most important part of lead generation is the offers that you extend to 
your audience. 


Use lead magnets* in your offer to help you gain more leads from your traffic. Here 
are some examples of lead magnets:


• A Gift

• A Coupon

• A Free Consultation

• Checklists

• Cheat Sheets

• Quizzes

• Videos

• Video Course

• Toolkit

• Calendar

• Podcast

• Interview

• Live Demo

• Tickets

• Email Course

• Physical Product
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• A Swipe File

• Infographic

• Phone Call

• Assessment

• Custom Pricing

• A T-Shirt

• Industry Statistics

• A How-To Guide

• PDF Download

• An e-Course

• An e-Book

• An Affiliate Program

• White Paper**

• Listicles

• A Webinar

• Templates

• A Free Trial

• Product samples

• A Training Video

• Case Studies

• Quizzes, Surveys, or Polls


What is a Lead Magnet? 

A lead magnet is an offer that you extend to your audience in 

exchange for their contact information.


What is a “White Paper”?

A white paper is a report or guide that informs readers about a 

complex issue and presents the issuing body's philosophy on the 
matter.


Tip: Use multiple lead magnets and split-test* them to see what 
works best. Keep your Cost per Lead (or CPL) as low as possible. 
Run your ads only while you are in-office to prevent "catching up" 
with leads overnight. A great target CPL is less than $1! If your CPL 
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is above $10, it may be time to rethink your offer —try a new or 
better lead magnet—or ad creatives (such as copy or design).

What is Split Testing?

Split testing is the act of measuring results on multiple creatives—be 

it content, copy, or design—to help you determine a winning strategy.


Lead Capture Forms


Lead capture forms are where you collect contact information from your audience. 
Typically, you would see a simple 3-part form containing the following information: 


You may also see qualifying questions. For example, in the real estate niche, you 
may see a multiple-choice question asking the prospective lead whether they want to 
"Buy, Sell, or Rent". Often, in this example, prospects whose only intent is to "Rent" 
real estate will either be tossed out or referred to a third party—as they do not qualify.


• Contact info


• Name


• e-Mail


• Phone number


• Company name (optional)


• Physical address (optional)

• Preferred Method of Contact

• Message (optional)


Tip: Use Instant Forms to lower your CPL and increase conversion 
rates. The faster the form loads, the more likely you are to capture 
the lead.
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Nurturing Your Leads


Lead nurture is the act of following up with your leads via automation (Workflows) or 
by contacting the lead directly via SMS, e-Mail, or Phone. You've probably heard "The 
fortune is in the follow-up" and this cannot be any more true. One of the best ways to 
achieve guaranteed results is to focus on your Workflow and continually build upon 
them, as they are central to the buyer's journey.


Tip: In 50% of use cases, your Workflow Trigger should be either an 
Instant Form or a contact form on your website. The other 50% of 
Workflows will either use Trigger Links or will not have a Trigger at 
all.

Tip: You can use Workflows to build guidelines for your employees by 
using the Task events.

Measuring Your Results


To use Ad Reporting in IMG Funnels, go to the Reporting tab from inside your 
dashboard. Here, you can view Google Ads, and Facebook Ads, track attribution, and 
view reports on calls and even appointments.
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Tip: You can also use the Reporting tab to help you monitor 
performance on Calls and Appointments.

Tip: Remember, your target CPL should be less than $10.
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Lesson 1: Content Strategy & Awareness


To create a successful content strategy, you must first have a clear understanding of 
your brand and what you want to achieve. Once you know your goals, you can create 
content that resonates with your target audience and helps you achieve your desired 
results. An effective content strategy will not only improve your brand awareness, but 
can also lead to increased sales, more website traffic, and higher engagement rates. 
To create a cohesive and effective content strategy, there are a few key elements you 
should keep in mind.


Getting Started


If you're not sure where to start with developing your content strategy, this section 
will give you some key tips. Here are a few terms to know:


Evergreen Content

Content that stays relevant year-round (hence the name). Expect an 

even flow of traffic.


Topical Content

Timely, relevant content that relates to a current issue will bring you a 

short burst or "spike" in traffic.


Targeted Advertisements

Advertisements and targeted content that are designed to speak 

"directly" to a single audience or segment.


Brand Awareness


Before we cover the different types of content, you must first understand the different 
stages of the buyer's journey. You may recall the "Ski Slope" analogy from a previous 
lesson.
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In this illustration, content is grouped into one of three categories:

1. Bunny Slopes (or evergreen content)

2. Blue Squares (or topical content)

3. Black Diamonds (or targeted advertisements)


These three categories coincide directly with the three phases of the Buyer's 
Journey:


1. Awareness

2. Consideration

3. Decision


To keep your traffic flowing naturally, you have to have leads and/or customers in all 
three phases. Keep this in mind when you are building your content strategy! If you're 
going to run targeted ads, make sure your evergreen and topical content is updated 
first. You don't want to make it difficult for newcomers to find an entry point.


Tip: Don't skip out on the evergreen content!

Evergreen Content


When it comes to content strategy and brand awareness, evergreen content is key. 
This type of content is timeless and relevant no matter when it is read. It is the 
foundation of a strong content strategy and can help build brand awareness and 
loyalty over time. There are many different types of evergreen content, but some 
examples include How-To guides, listicles*, and resource pages. This type of content 
is usually evergreen because it is helpful and informative, and can be applied to any 
number of situations. If you want to create a content strategy that will stand the test of 
time, focus on creating evergreen content that will be relevant and useful for years to 
come.
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What is a “Listicle”? *

A listicle is a piece of writing or other content presented wholly or 

partly in the form of a list.


Tip: When writing evergreen content, try not to focus on your current 
offers. Instead, focus on your business, your mission, the problem 
that the consumer is facing, and your solution to that problem.

Topical Content


When writing topical content, keep in mind that your content should be relevant to 
your audience and target market. Secondly, your content should be shareable, so that 
it can reach a larger audience and help to build your brand. And finally, your content 
should be engaging, so that readers will want to come back for more.


With these things in mind, let's take a look at some tips for creating great content that 
will help to build your brand and raise awareness for your business.


 
Write relevant and topical blog posts


When it comes to your content strategy, relevant content is the key. 
Write blog posts that are relevant to your target market and audience 
that will offer something of value to them. If you can write posts that 
are both informative and entertaining, even better!


Create shareable content

If you want your content to reach a larger audience and help to build 

your brand, make sure it is shareable. Create content that is easy to 
share across social media and other channels. Use engaging 
headlines and visuals to make your content more appealing and 
shareable.


Keep your content engaging

Finally, make sure your content is engaging. If readers enjoy your 

content, they will be more likely to come back for more. Use strong 
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writing, interesting topics, and helpful tips to keep your readers 
engaged.


Tip: By following these tips, you can create great content that will 
help to build your brand and raise awareness for your business. So 
get writing and start sharing your content today!

Targeted Advertisements


Targeted ads are those that are specifically targeted to a certain audience. For 
example, you might target ads to people who live in a certain area, who have visited 
your website in the past, or who have searched for similar products or services.


The key to targeted advertising is to make sure that your ad is relevant to your target 
audience. If your ad is not relevant, it will not be effective.


When creating a targeted ad campaign, it is important to consider the following:


Who is your target audience?


What are their needs and wants?


What are their interests?


What is the best way to reach them?


Once you have answered these questions, you can begin creating your ad 
campaign. Remember, the goal is to create relevant ads and that will reach your target 
audience.


Tip: If you have ever received an ad that wasn't relevant, you know 
how annoying it can be for a company to target you without your 
consent. Try not to target your audience until you have full brand 
awareness of an audience that is already considering your products 
or services.
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Lesson 2: Automation & Workflows


If you manage a website or blog, you know that there are a million little tasks that 
need to be done daily. From keeping your content fresh to promoting your site on 
social media, it can be easy to get bogged down in the details.


That's where automation and workflows come in. By taking care of the little things for 
you, automation and workflows can free up your time to focus on the bigger picture. In 
this lesson, we'll explore how automation and workflows can help you streamline your 
website or blog management.


Getting Started


We will be using the Buyer's Journey Workflow Series from the Demo Snapshot to 
demonstrate automation in this lesson.


Demo Snapshot *

Your Demo Snapshot was loaded into your account when you 

signed up for the free trial. This snapshot is free for all subscribers. For 
assistance, please contact us via Live Chat or call +1.205.891.6800.


Automation


Automations are computer-generated triggers and actions that perform tasks 
without the need for a human being to intervene. With the use of automation, you will 
be able to eliminate the human factor from the equation and save yourself lots of time 
and money.


There are several ways to create automation. Here, we've listed the different types of 
automation in order by difficulty:


• Workflows (easy)

• Automated Attendants

• Integrations (Zapier, etc.)


tel:12058916800
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• Advanced


• Webhooks


• Service workers (difficult)


In this lesson, we will cover each type of automation and how to use them.


Tip: Some automation is more difficult than others. Use what you can 
to help save you time and money and if you need help, feel free to 
reach out to your account manager for further assistance.

Workflows


In your dashboard, navigate to Automation > Workflows. You'll notice that you have a 
Folder titled "Buyer's Journey". Open the Buyer's Journey workflow and navigate to 
the "Buyer's Journey: Awareness" Workflow. Your screen should look like this:


Here we have a single Trigger * that listens for a form submission and then starts the 
workflow. The Buyer's Journey form that we are using came with the Demo Snapshot 
and you can integrate that form directly into your site using the Page Builder or an 
iframe.


 The first Action ** in this Workflow will add the lead into a Pipeline *** (more about 
this in the next lesson). From there, they are tagged **** with "Buyer's Journey" so that 
you can distinguish leads who have entered this workflow using tags.
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Then, the lead receives an email from the system. This email uses a Template with 
Custom Values to send the lead a personalized message with their name, their 
assigned user (or account manager), and an email signature that you can set up by 
navigating to Settings > Custom Values.


In this example, we are setting up an automated follow-up messaging system from a 
form submission. When the lead responds, we place them in a "Responded" column in 
the Pipeline for the assigned user to follow up and then we notify the assigned user 
that they have a warm lead that requires Manual Action on their part.


What is a Trigger? *

A trigger is an action that is performed by an end-user that starts a 

Workflow and provides the subsequent Actions with information about 
the user.


What is an Action? **

An Action is an automation that is performed by the system that 

operates before continuing to the next step (or Action) in the Workflow.


What is a Pipeline? ***

A Pipeline is a system similar to a Kanban board that is used to 

assist users in maintaining leads in the system. You can see an 
overview of your Pipeline from the Dashboard.


What is a Tag? ****

A "Tag" is an identifier that is used to either distinguish certain 

contacts in the system. You can also use Tags to trigger another 
Workflow.


Tip: Instant Forms (specifically Facebook Instant Forms) are a great 
way to capture leads! You can add an Instant Form Submission 
Trigger by clicking "Add a New Workflow Trigger" and searching for 
"Instant Form".

Tip: There are many different types of Triggers and Actions. Browse 
through the Trigger/Action menus to view more options.
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Example


In the next lesson, you will learn about Pipelines. To help prime you for that lesson, 
let's create a Workflow that will add a Customer to a Pipeline using a Form.


First, navigate to Automation > Workflows and create a new Workflow by selecting 
"Create workflow", then "Start from scratch", and then confirm by clicking "+ Create 
new workflow”.


From here, click "Add New Workflow Trigger", search for "form" and then click "Form 
Submitted”.


(see next page)
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Now, click "Add filters" and select "Form is" and then "BUYER'S JOURNEY" and 
then "Save Trigger”.


Great! You have just created your first Trigger.


(Make sure you save it!)
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Now, to continue with the example, let's create an Action to add the Contact into a 
Pipeline. Select "Add your first Action" and then search for "Opportunity". Click 
"Create/Update Opportunity", select the "Buyer's Journey" Pipeline, select the 
"Awareness" stage, use the Contact's name as the Opportunity name by clicking the 
tag icon on the Opportunity Name field, and then set the Source to "example". Set the 
Lead Value to "1000", set the Status to "Open", then click "Save Action", and then 
Save the Workflow by clicking the green button in the top right of the Workflow Editor.


Congratulations!! 🎉 


You have just created your first Workflow!


When a Contact fills out the “Buyer’s Journey” Form, they will be added to the 
Buyer's Journey Pipeline in the Awareness column. From here, you can follow the 
Buyer's Journey Workflow from the Demo Snapshot by opening the Workflow in the 
Editor and seeing everything that we've added here for you. You receive a notification 
when a lead comes in, they're assigned to a user, they receive an email and a text 
message, and the list of possibilities here is endless.


Later in this lesson, we will discuss third-party integrations with Webhooks, but that's 
sort of an advanced subject. From here, you have pretty much everything that you 
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would need to run your business online. Browse through the list of Triggers and 
Actions to learn more! Happy automating!


Tip: Automations save you time and money by reducing the number 
of manual actions that you have to perform. In the Buyer's Journey 
Workflow from the Demo Snapshot, the Contact will receive a list of 
20 emails and text messages over the course of ~30 days asking 
them to schedule an appointment. When the contact replies to an 
email or text message, the assigned user is notified and the 
Opportunity moves to the "Responded" column in the Pipeline. From 
there, the agent should handle the opportunity by confirming the 
appointment and then moving the Opportunity into the appropriate 
column in the Pipeline.

Automated Attendants


Have you ever called a number and got an automation that asked you to select an 
option from a menu using the dial pad (or voice)? That's an automated attendant.


While this is optional, you can get set up with an automated attendant by signing up 
with Google Workspace. The account is $6 per month for Google Workspace and $20 
per month for Google Voice Standard.
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Visit https://support.google.com/a/answer/9204988 to learn more.


Tip: Automated attendants are not an IMG Funnels feature, but 
they're easy to set up with Google Workspace and Google Voice. 
You can redirect callers from Google Voice to a number in your IMG 
Funnels account by setting up Call Handling with the appropriate 
phone number. There is currently a request to add automated 
attendants to IMG Funnels.
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Integrations


Zapier


There are several different platforms that you can integrate with IMG Funnels by 
using the LeadConnector App. LeadConnector is a third-party company that manages 
the integrations and apps for IMG Funnels. While several different platforms provide 
the same functionality, we recommend Zapier as it has the largest market share.


Simply add the LeadConnector app to your Zap and browse through all of the 
different integrations that you can create with Zapier.
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Make


Make has a similar flow to Zapier, but their Workflows take on a different look. There 
may be some features in Make that exist in Zapier and vice versa. With Make, you will 
use the HighLevel integration, which is another third party that manages integrations 
and apps for IMG Funnels.


Tip: If you need help, feel free to reach out to your account manager 
for further assistance.

⚠ Warning
The following automation methods (webhooks and service workers) 
are for advanced users only! You will not need to know these for 
the quiz.
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Advanced Integrations


Webhooks


Webhooks are a great way to get started with automation. If you don't know what a 
webhook is, it's a "shim" that is located at a specific URL that will accept input and 
produces a desired result.


Webhooks are similar to integrations. The only difference is that, with webhooks, 
there is little (or no) user interface. To get started with Webhooks, select the Webhook 
Action from the Action menu and paste your Webhook endpoint into the URL field.


In this example, we are sending a webhook to https://workers.imgfunnels.com/
webhook-example that receives a query parameter of "email" containing the contact's 
email address.


What is a Query Parameter? *

A query parameter is usually synonymous with a form field that is 

submitted by the contact. If your webhook endpoint has a "signature", 
the signature is usually fulfilled using query parameters.
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Tip: Inbound Webhook Workflow Triggers are now a part of IMG 
Funnels (as of 5/10/23).

Service Workers


Service Workers are similar to webhooks in that they receive information and 
produce a desired result. The difference with service workers is that they can output to 
multiple endpoints or even modify the system itself. Think of a webhook as a 
"forwarding service", whereas a service worker is a standalone function that receives a 
call over HTTPS and outputs to multiple endpoints.


We recommend Cloudflare Workers, but you can also spin up your service workers 
using webhooks and a server.


Tip: Service Workers are a highly advanced topic and a complete 
explanation is out of the scope of this lesson. If you need help, 
contact your account manager.
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Lesson 3: Using Pipelines


As mentioned in the Automation & Workflows lesson, a Pipeline is a system similar 
to a Kanban board that is used to assist users (agents) in maintaining leads in the 
system. You can see an overview of your Pipelines from the Dashboard.


Getting Started


We will be using the Buyer's Journey Workflow Series from the Demo Snapshot to 
demonstrate Pipelines in this lesson.


Opportunities


When you add a Contact to a pipeline, you create what's called an Opportunity. If you 
would like a Pipeline demo account to use while you're building your business, please 
contact your account manager and we will be more than happy to set you up with 
another account.


(see next page)
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Once you have loaded the Demo Contacts into your system, you can create 
Opportunities by clicking the "+ New" button at the top right of the Opportunities tab.


Tip: You can drag and drop Opportunities across Pipelines. If you 
Win or Lose a deal, you can also drop them into the "Win" or "Lose" 
bins to mark the deal as won or lost, respectfully.

Tip: In the previous lesson, you learned how to add a contact to a 
Pipeline by using a Form Trigger and a Create/Update Opportunity 
Action. You can add a Form to a funnel or website using the Page 
Builder, you can embed Forms on WordPress by clicking "Integrate 
Form" from the Form Builder, or you can use Instant Forms to add 
customers to your Pipeline using Workflows.

Automation


If you're running an agency, you can assist your sales agents by automating the 
Pipeline flow using Workflows! For example, you can move an Opportunity to the next 
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stage based on an action or you can move stale opportunities back to a Cold Inbound 
Lead stage, effectively placing the contact back at the beginning of the Pipeline.


Tip: You can automatically move Opportunities through Pipelines 
using the Create or Update Opportunity Action in Workflows.

Conversions & Winning Content


A conversion occurs when a lead completes a desired goal, such as filling out a form 
or making a purchase. Whether you are using Automation or managing your Pipeline 
manually, your goal is to convert your audience.


Since we are already in Pipelines, let's talk about converting your audience.


Unless you have a killer offer (like maybe you're giving away free Nikes), chances are 
you're going to need two things:


• An Offer that stands out

• Winning Content that backs it up


We determine winning content by gathering data and analytics on our audience and 
using those analytics to help us optimize our content for sales in the form of tracking. 
In a lesson in the future, we will cover Gathering Data & Analytics in-depth.
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Using Split Tests* (or Sprint Tests** in some cases) you can use your data and 
analytics to create an Offer that has a higher conversion rate, a lower bounce rate, and 
a higher Click-Through Rate (or CTR).


What is a “Split Test”? *

A split test is a way of testing two different versions of a system or 

interface to gather analytics and determine a "winner". Typically, the 
test with the lower bounce rate, or the higher CTR, is the winner.


What is a “Sprint Test”? **

A Sprint is a form of split testing, usually used with multiple Ad 

Creatives, that involves providing numerous versions to determine a 
"winner".


Tip: Gathering Data & Analytics is about more than just placing a tag 
on a Contact so that you can segment your audience later. It's about 
not losing control over those systems. Unless you're giving away free 
Nikes, you have you use your analytics 🧠  and not just your intuition 
to make sales. You're building a system, not a social experiment.

Tracking & Engagement


One way to track and measure customer engagement is by using Trigger Links to 
send Offers to your audience. You can Tag the Contact using a Workflow, and then 
segment your audience using Tags. You can use a Conditional If/Else Action in your 
Workflow to send reminders or updates. You could even move them into a different 
column in your Pipeline if they click on a specific Trigger Link and then respond 
accordingly.


 If you are using Trigger Links, you can grab the customer's contact information 
using a Workflow and then process an order given that their Customer ID is placed as 
a Custom Field in their Contact Info.
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Tip: You don't have to use a Trigger to put Contacts through a 
Workflow. You can simply add Contact in Bulk to a Workflow and 
then send them an Offer. For example, you can create an Event titled 
"Cyber Monday" and then create a Set Event Date Action to Cyber 
Monday, send out an SMS / Email "Blast", and then wait until the 
Event Start Date to send out your offer.
You can also use this method to add Contacts in Bulk to an Analytics 
platform, or a Facebook Audience, for example.

Advanced Tracking Methods


Learning Inbound Webhooks will require some basic programming skills, but they 
allow you to send Webhooks to IMG Funnels when specific actions are taken by the 
customer. The feature will implement an IoC methodology that allows the sender to 
define their signatures when sending webhooks.


⚠ Warning
This next section is for developers, so if you don't write code, it's 
not for you.
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e-Commerce


Leverage the Power of e-Commerce


e-Commerce is the buying and selling of goods or services over the Internet. This 
type of commerce is convenient for consumers because they can shop from the 
comfort of their own homes. Businesses can also benefit from e-Commerce because 
it allows them to reach a larger audience.


Getting Started


To start selling goods or services online, businesses need to set up a website and 
choose a payment processor.


You will need:


A WordPress Website


A Payment Processor


Platforms


Course Requirements:

You will need a WooCommerce account to test and manage your 

shop’s inventory.


Visit: https://woocommerce.com


When it comes to setting up an online store, there are many different e-commerce 
platforms to choose from. While some platforms are more popular than others, the 

https://woocommerce.com/
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best platform for your business will ultimately depend on your specific needs and 
goals.


Some of the most popular e-Commerce platforms include WooCommerce, Shopify, 
and Magento.


No matter what platform you ultimately choose, setting up an online store can be a 
great way to reach a larger audience and boost sales. If you’re ready to take your 
business online, consider one of these e-commerce platforms to get started.





WooCommerce


WooCommerce is a great option for businesses that want to use WordPress as their 
content management system and need an e-Commerce solution that integrates 
seamlessly.


Shopify


Shopify is a turnkey solution that is perfect for businesses that want an easy-to-use 
platform with all the bells and whistles.


Magento


Magento is a more robust platform that is perfect for businesses that need more 
flexibility and customization.


Tip: While it is possible to set up an e-Commerce store in IMG 
Funnels, we have integrations for most platforms and IMG Funnels is 
designed more for services and digital products—single-product 
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pages, where the user can check out on the same page that they 
view your products or services.

Payments


Course Requirements:

You will need a Stripe account to test payments.


Visit: https://stripe.com


There are many different payment processors out there, and it can be tough to know 
which one to choose for your e-commerce business. Here is a brief overview of some 
of the most popular payment processors, to help you make an informed decision.


Stripe


Stripe is a newer payment processor that is becoming very popular. It is very user-
friendly and has low fees. It is a good option for businesses of all sizes.


PayPal


PayPal is one of the most well-known and popular payment processors. It is easy to 
use and set up, and it has a good reputation. However, PayPal does have some fees, 
so be sure to check into that before using it.


https://stripe.com/
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Authorize.net


Authorize.net is another popular payment processor. It is a little more complex to set 
up than PayPal, but it is very reliable. It also has low fees, so it is a good option for 
businesses that process a lot of transactions.


Tip: Research to find out which payment processor is best for your 
company. If you already have a payment processor, you may want to 
consider integrating your e-commerce platform with the same 
payment processor that you use in-house.

Plugins


Whether you're using a platform like WordPress (with WooCommerce as a plugin) or 
Shopify, you have a plethora of plugins and add-ons that are available to you.


WooCommerce has an extensive list of official plugins that fit almost any use case. 
View official WooCommerce plugins here.


FYI

If you are only selling digital products and services, you may want to 

consider just using IMG Funnels and following the Part on Lead 
Generation instead. We will cover both IMG and WordPress solutions 
in this Part on e-Commerce, but if you aren't managing a large (20+ 
product) catalog of physical products, you may not need the lesson on 
Inventory Management, but you will be quizzed on it.


Digital Downloads


Visit: https://wordpress.org/plugins/easy-digital-downloads/


Easy Digital Downloads is a plugin that’s specifically designed for selling digital 
products. If you’re selling products that are downloaded after purchase, such as 
ebooks, music, or software, then this plugin is worth considering.


https://woocommerce.com/products/
https://wordpress.org/plugins/easy-digital-downloads/
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Visit: https://wordpress.org/plugins/themify-wc-product-filter/


Themify.me WooCommerce Product Filter





Themify.me WooCommerce Product Filter allows you to create unlimited product 
filters for WooCommerce. Users can refine product search by applying multiple filters/
conditions such as categories, tags, price, in-stock, on-sale, and even attributes such 
as colors and sizes.


Tip: Keep in mind that plugins slow your site down. Try to keep the 
number of plugins to a minimum or upgrade your hosting to improve 
performance.

https://wordpress.org/plugins/themify-wc-product-filter/
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Lesson 1: Adding Products to Your Site


Whether you're running an online store or a single-page sales funnel, you’ll need to 
add products to your site regularly. This can be a daunting task, especially if you're 
starting from scratch. In this lesson, we'll give you some tips on how to add products to 
your site quickly and easily.


Since it's easier to add products to single-page funnels, we will start there and then 
move on to larger inventories.


Getting Started


In this lesson, we're going to use Stripe as our payment processor. If you are using 
another payment processor, simply use your payment processor of choice to create a 
product if necessary.


Adding Products With Stripe


To create products, you will first need to integrate IMG Funnels with Stripe. If you 
have not yet done so, navigate to Settings > Integrations and then connect Stripe.


Once you've connected your Stripe account, you can add products by navigating to 
Payments > Products. Your products are managed by IMG Funnels, so there's no 
need to create products directly in Stripe. 
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Tip: You can create Free Trials for products with recurring payments 
(or subscriptions) and collect payments from users once their trial 
has ended. Make sure you provide your users with a way to manage 
their billing info by going to your Stripe Dashboard and creating a 
Customer Portal from Settings > Billing > Customer Portal.

Single-Page Funnels


Single-Page Funnels are sales funnels in their purest form. The goal of a sales funnel 
is to reduce the number of actions that a user has to take to purchase a product. The 
fewer actions that the user has to take, the more likely they are to convert! There are 
two types of order forms: One-Step Order and Two-Step Order. Once you have added 
a product to your Funnel or Website, you can then add an Order Form and your 
product will show up in the checkout. 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You can also add Bump Products* by going to the Order Form Settings > Advanced 
area and selecting a Bump Product. A Bump Product is a form of upsell that is 
designed to catch your customer's attention while they have a form of payment in 
hand.


What is a Bump Product?

A Bump Product is an upsell that you can place on your Order 

Forms. Upsells are highly effective at raising your Average Order Value 
(or AOV).


(see next page)
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Tip: If you create a Free Trial, make sure you have a way for your 
customers to manage their subscriptions. You can create a Customer 
Portal by navigating to your Stripe Dashboard and going to Settings 
> Billing > Customer Portal. From there, you can create a link to your 
Customer Portal, which you should share with your customer. In IMG 
Funnels, we place your Customer Portal in the sidebar located under 
Billing.

Tip: Add a Bump Product to your Order Form to increase your AOV.
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Online Stores


In IMG Funnels, Cart Mode* offers a way to purchase multiple products, but if you 
have over 20 products or products with more than 7 variants**, you might want to 
consider using an online store.


What is Cart Mode? *
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In your Order Form, go to Advanced Settings and search for "Main 
Product Options". Cart Mode allows your customer to select one or 
more from a list of products at checkout.


What are Variants? **

Variants are different variations of a single product. For example, 

different sizes and/or colors.


In the next lesson, we will cover adding products to a WordPress site with 
WooCommerce, an e-Commerce plugin designed to help you manage online stores.


Tip: You may not need to use an online store if your shop has less 
than 20, or so, products. It depends on how you want to manage 
your checkouts. If the single-page checkout suits you, then you 
should use it! On the other hand, if you need a more traditional e-
Commerce shop with rows of products and a standalone cart, you 
should use something like WooCommerce.
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Lesson 2: Inventory Management


If you're in charge of inventory at your company, then you know how important it is to 
keep track of everything that comes in and goes out. Overselling is one of the worst 
things that can happen to a business, so having a good inventory management 
system in place is essential. Fortunately, several software programs can help you with 
inventory management. 


There are a few different ways that you can keep track of your inventory.


Getting Started


We will cover some of the other platforms in another lesson, but for now let's focus 
on the giant with the highest overall market share: WooCommerce.


Installing WordPress


If you are already using a hosting service provider, it's likely that you already have a 
One-Click WordPress Installation feature or something similar. If you are not already 
using a hosting service provider, you can start with Google Hosting right from IMG 
Funnels. Simply click on Sites from your Dashboard, then click the WordPress tab.


Tip: Other hosting service providers, such as DreamHost (https://
dmholdingsinc.com/dreamhost), offer more flexibility when it comes 
to hosting plans. IMG Funnels offers migrations starting at $25. If you 
need help, contact your hosting service provider or send us a 
message!

Installing WooCommerce


WooCommerce makes it easy to track inventory and keep track of your stock levels. 
In this guide, we will show you how to install and configure WooCommerce to get 
started with inventory management.


https://dmholdingsinc.com/dreamhost
https://dmholdingsinc.com/dreamhost
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First, you will need to install the WooCommerce plugin. You can do this by 
navigating to Plugins > Add New and searching for “WooCommerce".


Once the plugin is installed, you will need to activate it. You can do this from the 
Plugins page in your WordPress admin area. Once WooCommerce is activated, you 
should follow the onboarding section titled "Let's Get You Started" found at the top of  
WooCommerce > Home.


After you have completed the onboarding, return to the Products area and click Add 
New.


Add a new product using the form provided. If you ever need to return to this product 
to Edit it, click the Edit button next to the product in the list view located in the Products 
area.
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From the Add/Edit Product page, you can choose to track inventory by product, by 
variation (or “variant”), or by SKU. You can also set up low stock notifications, so you 
can be alerted when your stock levels are low.


Once you have configured your inventory settings, you can start adding products to 
your WooCommerce store. To do this, you will need to go to the Products page and 
add a new product. On the product page, you can enter your product name, 
description, price, and other details. You will also need to select the Inventory tab and 
enter your stock level.


You can also set up backorders for your products. This allows customers to order 
products even if they are out of stock.


Once you have added your products, you can start selling them in your 
WooCommerce store.


Tip: Make sure that you have installed the WP Mail SMTP plugin. 
The default (PHP) mailer does not guarantee deliverability. If you 
need help with deliverability, we can install an SMTP for you starting 
at $5 per month, $0.001 per email, and $0.012 per email verification.
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Installing WP Mail SMTP


You can do this by navigating to Plugins > Add New and searching for "WP Mail 
SMTP". Once the plugin is installed, you will need to activate it. You can do this from 
the Plugins page in your WordPress admin area.


Bulk Editing Plugins


This is where inventory management starts to get sort of tricky. If you're just starting, 
you may want to consider using a plugin for bulk inventory management.


Free Plugins


As for free plugins, we recommend BEAR – Bulk Editor and Products Manager, but 
at the time of writing, another plugin called PW WooCommerce Bulk Edit seems to 
have gained attraction. If BEAR doesn't work for you, you may want to consider trying 
an alternative.
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Paid Plugins


As for paid plugins, we recommend the official WooCommerce Bulk Stock Edit 
Plugin (https://woocommerce.com/products/bulk-stock-management/).


Tip: You can install plugins from the WordPress plugin repository or 
by uploading the plugin files to your WordPress site.

FYI

If you are not a Database Administrator, this next section is not for 

you.


Doing it The "Old-Fashioned" Way (RDBMS)


If you are an experienced developer with a healthy knowledge of database 
management, let me let you in on a little secret. Products in WooCommerce are found 
in the database categorized as "Posts" (usually found in the `posts` table). Most of the 
WooCommerce tables (prefixed with `wc`) are junction (or lookup) tables.


https://woocommerce.com/products/bulk-stock-management/
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Lesson 3: 

Tracking & Follow-Up Automation


If you're shipping products, not only do you have to track your packages, but you 
also have to track your customer throughout their session to increase your conversion 
rates and optimize the user experience. For example, in Targeted Advertising (more 
about this in a lesson in the future) you track your visitors through a sales funnel, 
taking notes of the actions that they take to optimize your funnel for performance, 
performing Split Tests* as necessary.


Tracking is about more than just placing a tag on something so that you can find it. 
It's about not losing control over those systems. Unless you're giving away free Nikes, 
you have you use your analytics and not just your intuition to make sales. Your store is 
a system, not a social experiment.


FYI

For the sake of brevity, this lesson will teach you about Klaviyo for 

event tracking. Another (more advanced) course will teach you how to 
track events using Triggers, and/or Segment.


Getting Started


To follow along with the examples in this lesson, you will need to create a Klaviyo 
account (if you haven't already). Visit https://klaviyo.com (https://klaviyo.com).


Workflows (e-Commerce)


https://klaviyo.com
https://klaviyo.com
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Similar to how Workflows operate in IMG Funnels, we will be using "Flows" in Klaviyo 
to create an Abandoned Cart automation. While you can create this automation in IMG 
Funnels for single-page checkouts, in this lesson we will be focusing on larger online 
stores that use WooCommerce.


Installing Klaviyo


If you’re using WordPress, you can simply install Klaviyo as a plugin. You can do this 
by navigating to Plugins > Add New and searching for “Klaviyo”.


(see next page)


Follow the instructions to help you get started with tracking and follow-up 
automation for e-commerce. Connect your Klaviyo account to WooCommerce.


(see next page) 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If you integrated WooCommerce successfully, you will see this screen.


Tip: In the next section, you will see that Klaviyo automatically 
creates the default Flows for your shop whenever you integrate 
WooCommerce.

(see next page) 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Example: Abandoned Cart


Once you have Klaviyo installed, it's time to set up an Abandoned Cart Flow. Let's 
start by navigating to Flows in your Klaviyo Dashboard. Click on "Abandoned Cart".


✅  Click "Review and Turn On".


✅  Make sure that all of your Actions are set to “Live".


(see next page) 

https://www.klaviyo.com/flows
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Since this is a template, let's go through this Flow to make sure that we understand 
what is happening here. First, we wait for 4 hours after a customer has started a 
checkout. Then, we send an email with the Subject Line, "It looks like you left 
something behind...".


Click the Menu Icon at the top right of the Abandoned Cart Email 1 card and then 
click Edit. You will now find yourself in the Email Content Editor. This is where you will 
set the Subject Line, Preview Text, Sender's Name, and From Email Address. At the 
top right of the Flow Content area, click "Edit Email" and you will find yourself in the 
Email Template Editor.


(see next page)
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Here you can customize your email template to your liking. Once you're finished, 
click Save and Exit, and then Done. Back in the Flow Editor, you will notice that we wait 
for another 20 hours after the initial Abandoned Cart Email is sent and then we send 
another email letting the customer know that their cart is about to expire.


Congratulations! 🎉 


You've just set up an Abandoned Cart Flow.


Tip: A template is any type of document that contains "placeholders". 
In this case, we are automatically generating an Abandoned Cart 
Email by listing the items in the customer's cart when they abandon a 
checkout. This is done by looping over the line items in their cart 
using Dynamic Data.

Tip: You can browse a list of Flow Templates by visiting Klaviyo's 
Flow Library (https://www.klaviyo.com/library/flows).

Tip: Klaviyo also offers SMS automation.

https://www.klaviyo.com/library/flows
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WP Fusion


WP Fusion is a WordPress plugin that presents an easy way to integrate your 
WordPress site with IMG Funnels! You can easily integrate forms and view pages as 
though you're a visitor, detect changes in behavior, and bring your audience closer to 
your CRM.


Tip: Contact Support or visit https://wpfusion.com/ to install WP 
Fusion!

Review Requests


Digital and Virtual Products in WooCommerce are automatically marked as 
"Fulfilled" upon delivery. After you've given your customer some time to use the 
product, it's time to send a Review Request. However, if you are shipping physical 
products, it's up to you to mark the order as Fulfilled from your WooCommerce 
Dashboard. 


Here, we need to implement a form of tracking. Specifically, if you are drop-shipping 
or using an affiliate program that ships physical products, you need to get the 
shipment tracking codes from the fulfillment service and send those to your 
customers!


This way, when a customer receives their product, both you and your customer know 
that the order was delivered and you can mark your order as "Fulfilled". And again, 
after you've given your customer some time to use the product, it's time to send a 
Review Request. In Klaviyo, this is already done for you. You just have to mark the 
Order as "Fulfilled" and use the pre-built Product Review / Cross Sell Flow to 
automatically give the customer 4 days to try their product before sending a Review 
Request.


Never forget that you have tons of competitors out there that are trying to tarnish 
your reputation and it can be difficult to have false reviews removed from the internet. 
You need to remember to ask for Reviews from your customers when an order is 

https://wpfusion.com/
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fulfilled. You have to drown out the bad reviews with good reviews, and you have to 
listen to your customers.


After all, if you've spent the time to track the customer through a session, you should 
do your best to follow up and ensure that they are happy with their products.


Tip: Bear in mind that it's not free, but if you would like to automate 
the order fulfillment process in WooCommerce, you can purchase 
the WooCommerce Order Status Control Plugin (https://
woocommerce.com/products/woocommerce-order-status-control/) to 
have your orders automatically marked as "Fulfilled".

https://woocommerce.com/products/woocommerce-order-status-control/
https://woocommerce.com/products/woocommerce-order-status-control/
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Step 3: Execute.

Every project has an execution phase. With ranking algorithms taking over social 

media delivery, your goal is to find the perfect fit for your product and segment your 
audience according to interests and temperature. If you have a moment, check out 
Twitter’s open-source ranking algorithm here: https://github.com/twitter/the-algorithm. 
Try to avoid the Trial and Error method (by studying ranking algorithms) and adjust 
your content accordingly.


Another example of a ranking algorithm is Google’s PageRank algorithm: https://
en.wikipedia.org/wiki/PageRank.


Every project is different. What works for one project doesn’t always work for 
another. Execution means putting your project into production. It’s as simple as that. 
That’s why you need marketing! Because if you launch a product into production 
without doing the marketing, you’re going to fall—flat on your face. Trust me, I know 
from experience. When in doubt, reach out to an influencer.


Set goals.

Look at your audience and think—how many emails (or text messages) do you need 

to send per day? How many posts are you going to have to make? How many leads do 
you plan on accepting? How many customers can you accept? Prepare to execute. 
Follow the conventions. Create a lasting offer.


I’ve always used a planning tool to help me plan for my campaigns, and you have 
options to choose from. If you don’t like one app, try another:


• Geru

• Marketplan

• Funnelytics

I know there are more out there. These are just a few that I’ve used in the past to help 

me prepare for launching a campaign.

—


Furthermore, I want you to understand the importance of gathering granular data 
and creating observability. If you want more control over your business, go granular 
with your data! Take every detail that seems minor and put it on a visualization 
somewhere. In the end, you’re probably going to use it. Don’t crowd your vision with 
logs, windows, screens, and bloat. Instead, create a high-density visual dashboard to 
help you run your next project.


https://github.com/twitter/the-algorithm
https://en.wikipedia.org/wiki/PageRank
https://en.wikipedia.org/wiki/PageRank
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Here are a few options for observability platforms:


1. Datadog

2. Grafana

3. New Relic

4. SolarWinds

5. Dynatrace


I prefer Datadog, but you may find that another platform works well for you.




There are many, many more and a lot of marketers overlook this detail, which 
prevents them from scaling. You can’t scale something that you can’t visualize. Don’t 
hesitate to reach out to us so that we can help you get started with your dashboard. 

An example of an observability dashboard — Cloudflare on Datadog
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Because in the end, this is going to help you stay organized. If you have 10 domains 
that you run just by yourself on top of 20-something clients, you need to consider your 
website’s observability. 


Execute.


—


Instilling Good Habits


Before I conclude this section, I want to mention one thing that has changed my 
perspective on running a business.


“WE WILL ENCOURAGE YOU TO DEVELOP THE THREE GREAT VIRTUES OF A PROGRAMMER: 
LAZINESS, IMPATIENCE, AND HUBRIS.” 

– LARRY WALL, INVENTOR OF THE PERL PROGRAMMING LANGUAGE 

These words were spoken by someone who was somewhat influential to me during 
my career-changing decision to become a programmer. However, this is not good 
advice for someone who is in marketing.


There is a huge difference.

If you take anything away from this book, I want you to remember this one thing:


INSTILLING GOOD HABITS IN YOUR EMPLOYEES AND YOUR CLIENTS WILL HELP YOU SEPARATE 
THE GOOD FROM THE BAD. 

Lead by example. If you ever find yourself wondering why your clients are lazy, 
impatient, and utterly dick-headed, yet you are lazy, impatient, and hubristic, it’s 
probably because you’re instilling your habits into their lifestyle.


Get up off your ass and show your clients what it’s like to be a good client. Show your 
employees what it’s like to be a good employee.


Sure, you have to learn how to work while reducing overall expenditure. You have to 
learn how to get angry at slow things. You have to learn how to say what nobody else 
will say. 
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However, none of those things will help you learn—or teach—good habits. Practice 
good habits with your clients and with your employees. Don’t reward bad behavior. 
Wait until your client has succeeded before sending the bill. Don’t give an employee a 
bonus when they screw something up. Forgive people when they do wrong, but never 
forget how to point out the good from the bad.


If anything be lazy, impatient, and hubristic with yourself.
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Up & Running

(Continued)


Lesson 10: Reputation Management


Reputation management is the process of monitoring, protecting, and improving 
your company's or your reputation. It's important to have a good reputation so that 
customers will want to do business with you, and so that you can attract and retain the 
best employees.


Following these tips can help you maintain a good reputation and prevent or resolve 
reputation problems.


Getting Started


There are a few key things you can do to manage your reputation:


Send Review Requests.


Monitor what's being said about you or your company 
online


Respond quickly and appropriately to any negative 
comments or reviews


Proactively manage your online presence.


Foster positive relationships with customers, employees, 
and others.


Tip: Monitor your reviews by going to the Reputation area in your 
dashboard.
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Yext


Yext is a powerful tool for managing your online reputation. With Yext, you can 
control how your business appears across the web, including in search results, on 
social media, and review sites. Yext makes it easy to monitor your online reputation 
and respond to reviews and social media posts in one place. You can also use Yext to 
proactively improve your reputation by publishing positive content about your 
business across the web. If you're looking for a comprehensive solution for managing 
your online reputation, Yext is a great option.


Tip: IMG Funnels has a special discounted deal on Yext Listings, a 
part of Yext that deals with online listings and reputation 
management.

Sending Review Requests


Review Requests are one of the most important aspects of reputation management. 
By sending Review Requests, you can keep your name and brand in front of potential 
customers and clients. This allows you to stay top of mind and increase the likelihood 
that they will do business with you in the future.


Here are a few things to keep in mind when sending an invite to Review your 
company:
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Give your customer some time to use your products or 
services


Generally speaking, anywhere from 1 to 14 days should be allowed 
for the customer to actually use your products or services before you 
send a review request.


Make sure the invite is personal

A generic invite is more likely to be ignored than one that is 

addressed to the individual by name.


Keep the invite short and to-the-point

No one wants to read a long, drawn-out request.


Make sure the invite is relevant

Make sure you're sending a request to review the right company, 

product, or service.


Follow up!

After sending an invite, make sure to follow up with the person to see 

if they can attend. This shows that you are interested in their response 
and helps to solidify your relationship.


Tip: Don't send invites to just anyone. If the customer is unsatisfied 
with your products or services, attempt to resolve the issue in person 
rather than just moving on to the next step in a guideline or 
automation. If you get a negative review, respond calmly and create 
content to help "drown out" any bad reviews.

Monitoring Your Reputation


Monitoring your reputation is important when it comes to reputation management. 
You need to know what people are saying about you online, and you need to be able to 
respond quickly to any negative comments or reviews.
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Yext will automatically send you alerts when a customer reviews your business 
online or when someone comments on your posts. You can also set up Google Alerts 
for your name or your business, so you’ll be notified anytime someone mentions you 
online. You can also regularly check review sites like Yelp or Google Reviews to see 
what people are saying about your business.


If you see any negative comments or reviews, don’t panic. Take a deep breath and 
try to respond calmly and professionally. Thank the person for their feedback and see if 
there’s anything you can do to improve their experience. If you can’t fix the problem, at 
least you’ve shown that you’re willing to listen and try to make things right.


Monitoring your reputation isn't the only thing you need to do. You also need to make 
sure you’re proactively building a positive reputation. That means creating great 
content, interacting with your customers, and making sure you have a strong online 
presence.


Tip: Set up alerts with Yext or Google Alerts.



Think. Plan. Execute.  |  100

Lesson 11: Gathering Data & Analytics


In this lesson, we'll be discussing how to gather data and analytics to improve your 
website. We'll cover topics such as data collection methods, analyzing data, and using 
data to make decisions. By the end of this lesson, you should better understand how 
to use data to improve your business.


In-App Reporting


IMG Funnels comes with a built-in reporting module. To see reports, navigate to 
Dashboard > Reporting. 


Tip: The more Integrations that you have connected to IMG Funnels, 
the more reports you will have available to you. You should always 
split your campaigns across channels (Calls, Voicemails, Emails, 
SMS, Chat, Google, YouTube, LinkedIn, Facebook, Instagram, 
AdWords, etc.), both organic and paid, and gather analytics in one 
place. As a general rule, 40% of your traffic should be organic, while 
the other 60% is paid.
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Using a WordPress Plugin


If you're using WordPress, you can simply install MonsterInsights and follow the 
instructions to help you get set up with Google Analytics. You can do this by navigating 
to Plugins > Add New and searching for “MonsterInsights”.


Tip: MonsterInsights is just one of the many plugins on WordPress 
that are designed to help you gather analytics and use them to help 
you convert leads to customers. While it simplifies the Google 
Analytics integration, that's only one channel and some of the 
features are locked until you pay for the "Pro" version.
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More Plugins


Slimstat Analytics allows you to track almost anything from WordPress including 
returning customers and registered users, Javascript events, intrusions, and even 
email campaigns. Thousands of WordPress sites are already using it.


Download it at https://wordpress.org/plugins/wp-slimstat/ or navigate to Plugins > 
Add New and search for “Slimstat".


Tip: Slimstat allows you to use geolocation to track your visitors using 
their IP.

Using a Script


If you're installing Google Analytics on an IMG Funnels site, you can do so by 
navigating to Sites > Funnels or Sites > Websites. From there, you can install a global 
tracking code from the Settings Panel or you can install the tracking code directly onto 
a single page using the page builder under Settings > Tracking Code.


(see next page)
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You can also install the script on the dashboard if you're in the white-labeled affiliate 
program, you can track user activity directly in your B2B/B2C SaaS + CRM. Just 
navigate to Agency Account > Settings > Company and paste your tracking code into 
the Custom JavaScript field.


This method also works for Facebook Pixel and any other tracking scripts that you 
need to install.
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Tip: You can use this same method to install the Facebook Pixel / 
Conversions API. While you can track individual events (such as a 
phone call or a form submission), the process for setting that up 
depends on the type of event that you are tracking. If you need help 
tracking individual events, feel free to contact your IMG Funnels 
account manager for assistance.

Using Your Data


There are several ways you can use your data. Use your bounce rate* to determine 
whether your visitors are staying on your website. More time equals more money as 
long as you have CTAs and an effective content strategy.


Below is a chart of common industries and their average bounce rates. You should 
research your niche to find the average bounce rate and adjust your content 
accordingly. If your data is unpredictable and you're noticing a lot of spikes in your 
traffic, then you should attempt to add more evergreen content. If your bounce rate is 
high, you should post some topical content or consider readjusting your offer.


(see next page)
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CREDIT: BACKLINKO 

What is a “Bounce Rate”? *

A bounce rate is the percentage of visitors who navigate away from 

your site without taking action. If your bounce rate is high, that's a 
good indicator that your website is boring or off-putting.


Tip: A good target bounce rate is around 24%. Anything higher than 
that and you probably need to add more topical content.

GDPR Compliance


One thing to keep in mind is that platforms like Google Analytics are limited as to 
what they can track. For example, if you have your site running through Cloudflare and 
you compare the results from Google Analytics, you'll notice that your site might get 
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10x more traffic than what is recorded in Google Analytics. The reason for this is that 
Google Analytics cannot track things like bots, web crawlers, and certain browsers 
that disable Google Analytics.


You may recall the iOS 14 update from 2021 that limited apps like Facebook from 
tracking people (using a "Pixel") across the internet. The same rule applies to Google 
and all other analytics platforms that facilitate data vendors. Google Analytics is not 
GDPR compliant. To use Google Analytics on your website (and maintain 
compliance), you must first obtain consent from your users before you can activate it.


Not all hope is lost, though. Some platforms are GDPR compliant by default, such as 
Matomo (https://matomo.org/).


https://matomo.org/
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Lesson 12: Targeted Advertising


With the average person seeing between 4,000 and 10,000 ads in a single day, you 
need a way to "drill down" into your audience to reach the people who are the most 
interested in your products or services. For this, you need targeted advertisements.


Getting Started


There have been a few lessons in this course that have already mentioned 
"targeting". Fortunately, targeted advertisements are easy. You simply install a code on 
your website to help the platform target your audience and then pass any custom 
events to analytics.


Attracting an Audience


If you don't capture the audience's attention within the first 3-5 seconds of your ad, 
you're probably going to lose them. Targeted ads are no different. Don't bore your 
audience. Even though some of the people in your targeted audience may have 
already seen your ads, just remember that there are competitors out there who are 
also trying to attract your audience and gain their attention.


We recommend Canva (https://www.canva.com/) and Wondershare (https://
www.wondershare.com/) if you're just getting started. While there are a lot of options 
out there, these brands are relatively inexpensive when compared to others like them 
and they get the job done.


Tip: You have about 3-5 seconds to capture your audience's attention 
and then get your message across to them without boring them.

Targeting Your Audience


Targeting is the process of recording events and data from your audience and using 
analytics to help you reach the right people. 
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For example, here is a list of events that Facebook uses to help them target the right 
audience for your advertisements:


• Add Payment Info

• Add To Cart

• Add To Wishlist

• Complete Registration

• Contact

• Customize Product

• Donate

• Find Location

• Initiate Checkout

• Lead

• Page View

• Purchase

• Schedule

• Search

• Start Trial

• Submit Application

• Subscribe

• View Content


When you record any of these events, you can send them (along with the audience's 
data) back to the Facebook Conversions API using Workflows to help Facebook find 
users who are more likely to convert. For example, if someone views a Page with a 
Checkout and adds their Payment Info to start a Trial, you have 4 events that you can 
send to the Conversion API. In this example, the goal is to get the customer to 
purchase your products or services, and Facebook will deliver targeted ads to the 
customer until a "Purchase" event is recorded.


You have up to 7 events that you can record and anything after that is non-compliant 
with Apple's ATT Policies. If you send data to an Analytics Platform, you also have to 
stay within GDPR Policies. Compliance is important, so be careful. If you're unsure, 
you may want to check those policies before you use your audience's data.


Tip: Install your tracking code on your website and capture events via 
Workflows.
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Platforms 


While the latest trends are always going to control the flow of traffic between 
platforms, fortunately, the system is pretty much the same everywhere you go. In the 
Gathering Data & Analytics lesson, we learned about GDPR compliance. In a new 
trend, many advertisers are moving to platforms that practice GDPR by default.


For example, Apple has recently released its iOS 14 update with App Tracking 
Transparency and has subsequently gained a large market share.


(see next page)


Since Apple is a relatively new competitor on the scene, and little is known about its 
advertising platform, we will cover how to create Targeted Advertisements on Google 
and Facebook. It's up to you to apply the same principles to Apple Ads.
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Tip: You should almost always advertise with the platform that has 
the largest market share.

Google


Watch the video above to learn how to create an account on Google Ads Manager, 
and if you'd like to connect to YouTube (recommended), there is a video for that below! 
If you haven't already created a YouTube account, it's highly recommended, to go 
ahead and create one.


Tip: There will be more about this topic in the Advanced Courses.

Facebook


Targeted advertisements on Facebook are simple. All you have to do is install the 
Facebook Pixel on your website and you can use the Facebook Conversions API to 
track your visitors. Another option is to add visitors to your Audience or pass an event 
to the Conversion API using Actions in a Workflow. In the future, we hope to release 
Inbound Webhooks (estimated: Q1 2023).


Simply go to Facebook Ads Manager (https://facebook.com/adsmanager) and in the 
top left corner, click on the Menu icon and select "Events Manager" and then hover 
over the Sidebar or select All Tools > Connect Data Sources > Web to create a Pixel 
for your website.


Tip: There will be more about this topic in the Advanced Courses.

Others


Here is a list of some other advertising platforms that are also popular:


https://facebook.com/adsmanager
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1. Apple

2. TikTok

3. Bing

4. Instagram

5. Snapchat

6. Twitter

7. LinkedIn

8. Pinterest

9. Amazon
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That’s it!


That’s the end of Think. Plan. Execute. Visit our website to learn more! I will be 
releasing a new version of this book once every year or so, so stay tuned!


Thank you! 

https://imgfunnels.com


Author: Donald W. Moore Jr.

https://imgfunnels.com

